Nu-Link2-Pro Debugger and Programmer User Manual

The information described in this document is the exclusive intellectual property of Nuvoton Technology Corporation and shall not be reproduced without permission from Nuvoton.

Nuvoton is providing this document only for reference purposes of NuMicro microcontroller based system design. Nuvoton assumes no responsibility for errors or omissions. All data and specifications are subject to change without notice.

For additional information or questions, please contact: Nuvoton Technology Corporation.

www.nuvoton.com
# Table of Contents

1 INTRODUCTION ........................................................................................................... 9
  1.1 Nu-Link2-Pro Features ...................................................................................... 10

2 GETTING STARTED WITH NU-LINK2-PRO ........................................................... 11
  2.1 Nu-Link2-Pro Kit Contents .............................................................................. 11
  2.2 Nu-Link2-Pro PCBA ......................................................................................... 12
  2.3 Nu-Link2-Pro Overview ................................................................................... 13

3 CONNECTING THE NU-LINK2-PRO ................................................................. 15
  3.1 Nu-Link2-Pro Compatible Extension Connectors ........................................... 15
  3.2 SWD Interface Pin Definition and Function Connection .......................... 16
    3.2.1 ICE Programming Connection .............................................................. 16
    3.2.2 Virtual COM Connection .................................................................... 17
    3.2.3 Automatic IC Programming Connection ........................................ 18
  3.3 Bridge Interface Pin Definition and Function Connection .................. 20
    3.3.1 UART Connection .................................................................................. 20
    3.3.2 IFC Connection ..................................................................................... 21
    3.3.3 SPI Connection ...................................................................................... 23
    3.3.4 RS-485 Connection ................................................................................. 24
    3.3.5 CAN BUS Connection ........................................................................... 25
    3.3.6 PWM and Capture .................................................................................. 26
    3.3.7 ADC Connection .................................................................................... 27
    3.3.8 GPIO Connection .................................................................................... 28
  3.4 ETM Interface Pin Definition and Function Connection ........................ 30
    3.4.1 SWD Connection .................................................................................... 30
    3.4.2 ETM Connection .................................................................................... 31
  3.5 ICP Offline Programming Function Connection ...................................... 31

4 DEBUGGING AND PROGRAMMING ........................................................................ 33
  4.1 Debugging ......................................................................................................... 33
    4.1.1 Debug Mode ............................................................................................ 33
    4.1.2 Breakpoints ............................................................................................ 33
    4.1.3 System Viewer ........................................................................................ 33
    4.1.4 Semihost ................................................................................................ 35
    4.1.5 Embedded Trace Macrocell (ETM) ........................................................ 36
  4.2 Programming ...................................................................................................... 37
4.2.1 ICP Online Programming ................................................................. 37
4.2.2 ICP Offline Programming ............................................................... 37
4.2.3 ISP Online Programming ............................................................... 38
4.2.4 Software Serial Number (SN) .......................................................... 38
4.3 Wide Voltage Programming .............................................................. 39
4.4 Installing the Nu-Link2-Pro Driver ....................................................... 39
5 INSTALLATION AND SETUP ............................................................ 40
5.1 Connecting to the Nu-Link2-Pro ......................................................... 40
5.2 Software Setup ..................................................................................... 41
5.2.1 ICP Tool .......................................................................................... 41
5.2.2 Keil MDK ......................................................................................... 45
5.2.3 IAR EWARM ................................................................................... 54
5.2.4 NuEclipse GCC .............................................................................. 59
5.2.5 ISP Tool .......................................................................................... 66
5.2.6 More Features of Nu-Link2-Pro Firmware ........................................ 70
6 Appendix .............................................................................................. 72
6.1 Nu-Link2-Pro Operating Current of ICP .......................................... 72
6.2 Nu-Link2-Pro Operating Current of ISP .......................................... 73
6.3 Automatic IC Programming System ................................................. 74
6.3.1 Operation Sequence and Waveform ............................................. 74
6.1 Nu-Link Debugger and Programmer Comparison ........................... 76
7 Revision History .................................................................................... 78
List of Figures

Figure 2.1-1 Nu-Link2-Pro Full Kit Contents ................................................................. 11
Figure 2.2-1 Front View of Nu-Link2-Pro PCBA .............................................................. 12
Figure 2.2-2 Rear View of Nu-Link2-Pro PCBA .............................................................. 12
Figure 2.3-1 Nu-Link2-Pro Connector and Function Overview ........................................ 13
Figure 3.1-1 Pin Definition of Nu-Link2-Pro Connectors .................................................. 15
Figure 3.2-1 SWD Interface Connection Diagram for ICE ............................................. 17
Figure 3.2-2 SWD Interface Connection Diagram for Virtual COM .................................. 18
Figure 3.2-3 SWD Interface Connection Diagram for Automatic IC Programming ............ 19
Figure 3.3-1 Bridge Interface Connection Diagram for UART .......................................... 21
Figure 3.3-2 Bridge Interface Connection Diagram for I²C ............................................. 22
Figure 3.3-3 Bridge Interface Connection Diagram for SPI ............................................. 23
Figure 3.3-4 Bridge Interface Connection Diagram for RS-485 ....................................... 24
Figure 3.3-5 Bridge Interface Connection Diagram for CAN BUS .................................. 25
Figure 3.3-6 Bridge Interface Connection Diagram for PWM ......................................... 26
Figure 3.3-7 Bridge Interface Connection Diagram for ADC .......................................... 27
Figure 3.3-8 Bridge Interface Connection Diagram for GPIO ......................................... 28
Figure 3.4-1 ETM Interface Connection Diagram for SWD and ETM Function ............... 31
Figure 3.5-1 ICP Offline Programming Illustration of SWD Interface ............................... 32
Figure 4.1-1 Setting Breakpoints in Keil MDK Debug Mode ........................................... 33
Figure 4.1-2 System Viewer Control Related Options in Keil MDK Debug Mode ............. 34
Figure 4.1-3 System Viewer in Keil MDK Debug Mode .................................................. 35
Figure 4.1-4 Semihost Options in Keil MDK Debug Mode ............................................. 36
Figure 4.2-1 Online Programming Flow Diagram .......................................................... 37
Figure 4.2-2 Offline Programming Flow Diagram .......................................................... 38
Figure 4.2-3 Software Serial Number (SN) Settings ....................................................... 39
Figure 5.1-1 Nu-Link2-Pro Connection Diagram ............................................................ 40
Figure 5.2-1 Startup Screen of ICP Tool ......................................................................... 41
Figure 5.2-2 ICP Tool Main Window .............................................................................. 41
Figure 5.2-3 Select One Nu-Link2-Pro ........................................................................... 42
Figure 5.2-4 ICP Tool Programming Options ................................................................. 42
Figure 5.2-5 Nu-Link2-Pro Connected with a Target Chip Detected ................................. 43
Figure 5.2-6 Nu-Link2-Pro Connected with No Target Chip Detected ............................. 43
Figure 5.2-7 Programming File Selection Window ......................................................... 44
Figure 5.2-8 Programming Completion Window ............................................................. 44
Figure 5.2-9 Warning Message of “Device not found” ..................................................... 45
Figure 5.2-10 Project File Migrate to Version 5 Format ............................................. 45
Figure 5.2-11 Enable Debug Information for Keil MDK ............................................ 46
Figure 5.2-12 Debugger Setting in Options Window .................................................. 46
Figure 5.2-13 Programming Setting in Options Window ............................................ 47
Figure 5.2-14 Nu-Link2-Pro Parameter Settings ....................................................... 47
Figure 5.2-15 Keil MDK Programmer Selection ....................................................... 48
Figure 5.2-16 Nu-Link2-Pro Programming Settings .................................................. 48
Figure 5.2-17 Compile and Download the Project ..................................................... 49
Figure 5.2-18 Keil MDK Debug Mode ........................................................................ 49
Figure 5.2-19 Debug Message on Serial Port Terminal Windows ............................... 50
Figure 5.2-20 Open M480 project .............................................................................. 50
Figure 5.2-21 Trace Setup with ETM .......................................................................... 51
Figure 5.2-22 Initialize File for Trace Pins .................................................................. 51
Figure 5.2-23 Build and Download Windows for ETM .............................................. 52
Figure 5.2-24 Tracing Information Dialog .................................................................. 52
Figure 5.2-25 Breakpoint setting and Execution .......................................................... 53
Figure 5.2-26 Options Selection .................................................................................. 54
Figure 5.2-27 IAR EWARM Target Chip Selection .................................................... 54
Figure 5.2-28 Set IAR EWARM as Third-Party Driver for Debugger & Programmer ...... 55
Figure 5.2-29 IAR EWARM Programming Settings .................................................. 55
Figure 5.2-30 Select.board File for IAR EWARM ...................................................... 56
Figure 5.2-31 Set the Path of the IAR EWARM Debugger Driver Plugin .................... 56
Figure 5.2-32 Specify the Port and Target I/O Voltage .............................................. 57
Figure 5.2-33 Compile and Download the Project ..................................................... 57
Figure 5.2-34 IAR EWARM Debug Mode .................................................................. 58
Figure 5.2-35 Debug Message on Serial Port Terminal Windows ............................... 58
Figure 5.2-36 Import the Project in NuEclipse ......................................................... 59
Figure 5.2-37 Import Projects Windows ..................................................................... 59
Figure 5.2-38 Open Project Properties Window ....................................................... 60
Figure 5.2-39 Project Properties Settings ................................................................. 60
Figure 5.2-40 Build Project ....................................................................................... 61
Figure 5.2-41 Open Debug Configuration ................................................................. 62
Figure 5.2-42 Main Tab Configuration ...................................................................... 62
Figure 5.2-43 Debugger Tab Configuration ............................................................... 63
Figure 5.2-44 Debugger Tab Configuration ............................................................... 64
Figure 5.2-45 NuEclipse Debug Mode ..................................................................... 65
Figure 5.2-46 Debug Message on Serial Port Terminal Windows ................................. 65
Figure 5.2-47 Startup Screen of ISP Tool ........................................................................ 66
Figure 5.2-48 ISP is not connected to any device of ISP Tool ........................................ 66
Figure 5.2-49 ISP Firmware Sample Code Project ......................................................... 67
Figure 5.2-50 Boot from LDROM Setting in Keil ISP Firmware Project ........................... 68
Figure 5.2-51 Connect to Target Chip with SPI Interface .............................................. 68
Figure 5.2-52 Select VCOM Port Number with UART Interface ................................. 69
Figure 5.2-53 Program Data to Target Chip with SPI Interface .................................... 70
Figure 5.2-54 Update Nu-Link2 Firmware or DUT Firmware ...................................... 71
Figure 6.3-1 SWD Connector Pin Diagrams ................................................................. 74
Figure 6.3-2 PASS Waveform ..................................................................................... 74
Figure 6.3-3 FAIL Waveform ..................................................................................... 75
List of Tables

Table 1.1-1 Nu-Link Debugger/ Programmer Technical Abbreviations .............................................. 9
Table 2.3-1 Status LEDs Difference List ................................................................................................. 14
Table 3.2-1 SWD Interface Pin Definition and Description ................................................................. 16
Table 3.2-2 SWD Interface Corresponding Pin for ICE ............................................................... 17
Table 3.2-3 SWD Interface Corresponding Pin for Virtual COM .................................................. 18
Table 3.2-4 SWD Interface Corresponding Pin for Automatic IC Programming .......................... 19
Table 3.3-1 Bridge Interface Pin Definition and Description .......................................................... 20
Table 3.3-2 Bridge Interface Corresponding Pin for UART .......................................................... 21
Table 3.3-3 Bridge Interface Pin for I^C ......................................................................................... 22
Table 3.3-4 Bridge Interface Corresponding Pin for SPI ............................................................... 24
Table 3.3-5 Bridge Interface Corresponding Pin for RS-485 .......................................................... 25
Table 3.3-6 Bridge Interface Corresponding Pin for CAN BUS .................................................. 26
Table 3.3-7 Bridge Interface Corresponding Pin for PWM .......................................................... 27
Table 3.3-8 Bridge Interface Corresponding Pin for ADC ............................................................ 28
Table 3.3-9 Bridge Interface Corresponding Pin for GPIO .......................................................... 29
Table 3.4-1 ETM Interface Pin Definition and Description ............................................................ 30
Table 5.2-1 Debugger Function Settings Description ......................................................................... 48
Table 5.2-2 Connection Interface Option of ISP Tool .......................................................................... 67
Table 5.2-3 Entering the ISP Conditions for ISP Tool Connection .................................................. 69
Table 6.1-1 Nu-Link2-Pro Operating Current (Online Programming) ............................................ 72
Table 6.1-2 Nu-Link2-Pro Operating Current (Offline Programming) of SPI Flash .................. 72
Table 6.1-3 Nu-Link2-Pro Operating Current (Offline Programming) of USB Flash .................. 72
Table 6.1-4 Nu-Link2-Pro Operating Current (Offline Programming) of Micro SD Card .......... 72
Table 6.2-1 Operating Current of ISP Online Programming ............................................................. 73
Table 6.1-1 Comparison of All Nu-Link Debugger and Programmer ............................................... 76
Table 6.1-2 Comparison of Integrated Nu-Link Debugger and Programmer on Development Board .................................................................................................................. 77
1 INTRODUCTION
The Nu-Link2-Pro is a powerful Debugger and Programmer for Nuvoton NuMicro® Family microcontrollers. The usage of Nu-Link2-Pro can vary from software and hardware development to mass production.

The Nu-Link2-Pro Debugger and Programmer provides SWD and ETM debugging and emulator support for the NuMicro® Family microcontrollers. The system can program target chips based on In-Circuit Programming (ICP) and SWD interface. The NuMicro® Family microcontroller programming are supported by a diverse range of IDEs, such as Keil MDK, IAR EWARM, and NuEclipse GCC. With the Nu-Link2-Pro, users can program and debug directly on IDEs with full access and visibility into the microcontrollers.

The Nu-Link2-Pro can be used as a mass production programmer for NuMicro® Family microcontrollers. The programming system is based on In-Circuit Programming (ICP) and SWD interface. The Nu-Link2-Pro can work with Nuvoton NuMicro® ICP Programming Tool, or serve as a stand-alone ICP programmer. It also provides a control bus interface that can connect to Automated IC programming system. The programming process can be triggered by ICP Programming tool, Physical button, or Automated IC programming system.

The Nu-Link2-Pro is also an In-System Programming (ISP) programmer. It can work with Nuvoton NuMicro® ISP Programming Tool, or serve as a stand-alone (Offline) ISP programmer. It provides multi-interfaces bridge, such as UART, RS-485, USB, I²C, SPI, and CAN, to perform ISP function to NuMicro® Family microcontrollers.

The Nu-Link2-Pro provides a Virtual COM part for a microcontroller to communicate to PC. It also supports multi-interfaces, such as UART, RS-485, I²C, SPI, and CAN analyzer function. For DAPLink and PyOCD, Nuvoton provides dedicated firmware of Nu-Link2-Pro to support them.

For simplicity and clarity, parts of specific terms in this user manual are contracted or abbreviated, as listed in Table 1.1-1.

<table>
<thead>
<tr>
<th>Short Name</th>
<th>Full Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>NuMicro® Family</td>
<td>Nuvoton NuMicro® Family</td>
</tr>
<tr>
<td>ICP Tool</td>
<td>Nuvoton NuMicro® ICP Programming Tool</td>
</tr>
<tr>
<td>Keil MDK</td>
<td>Keil ARM Microcontroller Development Kit (MDK-ARM®)</td>
</tr>
<tr>
<td>IAR EWARM</td>
<td>IAR Embedded Workbench for ARM</td>
</tr>
<tr>
<td>NuEclipse GCC</td>
<td>NuEclipse Integrated Development Environment</td>
</tr>
<tr>
<td>SWD</td>
<td>Serial Wire Debug</td>
</tr>
<tr>
<td>ICP</td>
<td>In-Circuit Programming</td>
</tr>
<tr>
<td>ISP</td>
<td>In-System Programming</td>
</tr>
<tr>
<td>ETM</td>
<td>Embedded Trace Macrocell</td>
</tr>
</tbody>
</table>

Table 1.1-1 Nu-Link Debugger/ Programmer Technical Abbreviations
1.1 Nu-Link2-Pro Features

- Supports programming and debugging of all NuMicro® Family microcontrollers
- Supports In-Circuit Programming (ICP)
  - Selectable SWD output voltage (1.8 V / 2.5 V / 3.3 V / 5.0 V)
  - ICP Programming Tool with image file protection
  - Drag & drop Flash programming
  - USB flash drive, SD card and SPI Flash as image file storage
  - Start button
  - Automatic IC programming system connector (Control Bus)
  - Powered by Micro USB or target-powered via SWD interface
- Support In-System Programming (ISP)
  - Via multi-interfaces bridge
  - Supports PC control ISP
  - Supports ISP Programming Tool
- Supports multi-debug interfaces and tool
  - Supports Serial Wire Debug (SWD)
  - Supports high speed up to 96 MHz of Embedded Trace Macrocell (ETM)
  - Unlimited breakpoint and step execution
  - Supports Arm DAPLink
  - Supports PyOCD
- Supports multi-interfaces analyzer
  - SPI, I²C, CAN and RS-485 signal monitor
- Supports Multiple bridge connect
  - multi-interfaces bridge for ISP function (I²C, SPI, CAN, UART, RS-485)
  - Virtual COM port by USB
2 GETTING STARTED WITH NU-LINK2-PRO

2.1 Nu-Link2-Pro Kit Contents

Figure 2.1-1 Nu-Link2-Pro Full Kit Contents

Figure 2.1-1 shows the contents of Nu-Link2-Pro full kit:

- Nu-Link2-Pro main body (2952mil x 1968mil x 688mil)
- USB cable (0.3m, high-speed, Micro-B)
- ETM cable (50-mil 20-pin IDC flat cable with 50-mil 20-pin connectors)
- SWD cable (100-mil 10-pin squid cable with 10 x 100-mil sockets)
- Bridge cable (100-mil 20-pin squid cable with 20 x 100-mil sockets)
2.2 Nu-Link2-Pro PCBA

Figure 2.2-1 Front View of Nu-Link2-Pro PCBA

Figure 2.2-1 shows the main components and connectors from the front side of Nu-Link2-Pro PCBA. The following lists components and connectors from the front view:

- Main Chip: M48SKIDAE
- Micro SD Card Slot
- Micro USB Connector
- USB Connector
- Bridge Connector
- SWD Connector
- Start Button
- ETM Connector

Figure 2.2-2 Rear View of Nu-Link2-Pro PCBA

Figure 2.2-2 shows the main components and connectors from the rear side of Nu-Link2-Pro PCBA. The following lists components and connectors from the rear view:
2.3 Nu-Link2-Pro Overview

Figure 2.3-1 shows the Nu-Link2-Pro profile and connector overview, the following lists of function brief description:

- **USB Connector (CON5)**
  - USB Flash Drive for ICP Offline Programming

- **Micro USB Connector (J2)**
  - Micro USB port of a PC to debug and program target chips through the development software tool

- **Bridge Connector (CON6)**
  - UART (Only supports multi-interfaces analyzer related information transmission)
  - I²C Transmission Interface
  - SPI Transmission Interface
  - RS-485 Transmission Interface
  - CAN BUS Transmission Interface
  - PWM/Capture
  - ADC
  - GPIO

- **SWD Connector (CON4)**
  - SWD Host Interface
  - ICP Offline Programming
  - Virtual COM by UART
  - Automatic IC Programming
Nu-Link2-Pro Debugger and Programmer

- ETM Connector (CON3)
  - ETM Interface
  - SWD Host Interface
- Start Button (SW1)
  - Click this button to proceed with offline programming
- Micro SD Card Slot
  - Save bin file for ICP Offline Programming
- Status LED (ICES0, ICES1, ICES2, ICES3)
  - Display the operation status of the Nu-Link2-Pro

<table>
<thead>
<tr>
<th>Nu-Link2-Pro Operation Status</th>
<th>Status LED</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ICE</td>
</tr>
<tr>
<td>Boot</td>
<td>Flash×3</td>
</tr>
<tr>
<td>One Nu-Link2-Pro selected to connect</td>
<td>Flash×3</td>
</tr>
<tr>
<td>ICE Online (Not connected with a target chip)</td>
<td>On</td>
</tr>
<tr>
<td>ICE Online (Connected with a target chip)</td>
<td>On</td>
</tr>
<tr>
<td>ICE Online (Failed to connect with a target chip)</td>
<td>On</td>
</tr>
<tr>
<td>During Offline Programming</td>
<td>-</td>
</tr>
<tr>
<td>Offline Programming Completed</td>
<td>On</td>
</tr>
<tr>
<td>Offline Programming Completed (Auto mode)</td>
<td>On</td>
</tr>
<tr>
<td>Offline Programming Failed</td>
<td>On</td>
</tr>
</tbody>
</table>

Table 2.3-1 Status LEDs Difference List
3 CONNECTING THE NU-LINK2-PRO

This chapter introduces how to connect the Nu-Link2-Pro to a computer, and how to connect individual connectors to development board or products.

3.1 Nu-Link2-Pro Compatible Extension Connectors

Figure 3.1-1 shows the Nu-Link2-Pro definition pin of each connector, the Nu-Link2-Pro mainly contains USB, Micro USB, Bridge interface, ETM interface and SWD interface. User can freely select a suitable interface for debugger and programmer.

![Diagram of Nu-Link2-Pro Connectors]

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>CON3.2</td>
<td>CON3.4</td>
<td>CON3.6</td>
<td>CON3.8</td>
<td>CON3.10</td>
<td>CON3.12</td>
<td>CON3.14</td>
<td>CON3.16</td>
<td>CON3.18</td>
<td>CON3.20</td>
</tr>
<tr>
<td>CON3.1</td>
<td>CON3.3</td>
<td>CON3.5</td>
<td>CON3.7</td>
<td>CON3.9</td>
<td>CON3.11</td>
<td>CON3.13</td>
<td>CON3.15</td>
<td>CON3.17</td>
<td>CON3.19</td>
</tr>
<tr>
<td>VCC33</td>
<td>GND</td>
<td>GND</td>
<td>KEY</td>
<td>GNDetect</td>
<td>GND</td>
<td>NC</td>
<td>NC</td>
<td>GND</td>
<td>GND</td>
</tr>
</tbody>
</table>

USB Host: USB flash disk off-line programming.
USB Device: Connect to PC.

Bridge Connector

<table>
<thead>
<tr>
<th>TX</th>
<th>CON6.1</th>
<th>CON6.2</th>
<th>RX</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCL</td>
<td>CON6.3</td>
<td>CON6.4</td>
<td>SDA</td>
</tr>
<tr>
<td>S5</td>
<td>CON6.5</td>
<td>CON6.6</td>
<td>CLK</td>
</tr>
<tr>
<td>MOSI</td>
<td>CON6.7</td>
<td>CON6.8</td>
<td>MISO</td>
</tr>
<tr>
<td>RS485_A</td>
<td>CON6.9</td>
<td>CON6.10</td>
<td>RS485_B</td>
</tr>
<tr>
<td>CAN_H</td>
<td>CON6.11</td>
<td>CON6.12</td>
<td>CAN_L</td>
</tr>
<tr>
<td>ADC</td>
<td>CON6.13</td>
<td>CON6.14</td>
<td>VCC33</td>
</tr>
<tr>
<td>PWM</td>
<td>CON6.15</td>
<td>CON6.16</td>
<td>VCC33</td>
</tr>
<tr>
<td>GPIO0</td>
<td>CON6.17</td>
<td>CON6.18</td>
<td>GPIO0</td>
</tr>
<tr>
<td>GPIO1</td>
<td>CON6.19</td>
<td>CON6.20</td>
<td>GPIO1</td>
</tr>
</tbody>
</table>

ETM Connector

SWD Connector

<table>
<thead>
<tr>
<th>BUSY</th>
<th>START</th>
<th>NC</th>
<th>PASS</th>
<th>FAIL</th>
<th>ICE_TX</th>
<th>ICE_RX</th>
</tr>
</thead>
<tbody>
<tr>
<td>CON4.2</td>
<td>CON4.4</td>
<td>CON4.6</td>
<td>CON4.8</td>
<td>CON4.10</td>
<td>ICE_DAT</td>
<td>ICE_CLK</td>
</tr>
<tr>
<td>CON4.1</td>
<td>CON4.3</td>
<td>CON4.5</td>
<td>CON4.7</td>
<td>CON4.9</td>
<td>nRESET</td>
<td>GND</td>
</tr>
</tbody>
</table>

Figure 3.1-1 Pin Definition of Nu-Link2-Pro Connectors
3.2 SWD Interface Pin Definition and Function Connection

Table 3.2-1 shows SWD interface pin definition and description. The Nu-Link2-Pro provides a SWD interface connector with a 100-mil 10-pin cable. The SWD supports ICE Programming, Virtual COM and automatic IC Programming. The following sections will introduce the definition of the SWD interface pin and the connection of each function.

<table>
<thead>
<tr>
<th>Pin Name</th>
<th>Pin Number</th>
<th>Pin Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VCC</td>
<td>CON4.1</td>
<td>Target Board voltage supply. The Nu-Link2-Pro supports the wide voltage programming function, by ICP tool can adjust the SWD port voltage as 1.8V, 3.3V, 2.5V or 5.0V. For detailed adjustment method, please refer to section 4.3.</td>
</tr>
<tr>
<td>BUSY</td>
<td>CON4.2</td>
<td>“BUSY” is Control Bus signals for IC Programmer. For details, please refer to section 6.3.</td>
</tr>
<tr>
<td>ICE_DAT</td>
<td>CON4.3</td>
<td>Serial Wired Debugger Data pin</td>
</tr>
<tr>
<td>START</td>
<td>CON4.4</td>
<td>“START” is Control Bus signals for IC Programmer. For details, please refer to section 6.3.</td>
</tr>
<tr>
<td>ICE_CLK</td>
<td>CON4.5</td>
<td>Serial Wired Debugger Clock pin</td>
</tr>
<tr>
<td>NC</td>
<td>CON4.6</td>
<td>NC</td>
</tr>
<tr>
<td>/RESET</td>
<td>CON4.7</td>
<td>IC reset pin, Nu-Link2-Pro will automatically reset the target IC during the programming process.</td>
</tr>
<tr>
<td>PASS/TX</td>
<td>CON4.8</td>
<td>“PASS” is Control Bus signals for IC Programmer. For details, please refer to section 6.3.</td>
</tr>
<tr>
<td>GND</td>
<td>CON4.9</td>
<td>Ground</td>
</tr>
<tr>
<td>FAIL/RX</td>
<td>CON4.10</td>
<td>“FAIL” is Control Bus signals for IC Programmer. For details, please refer to section 6.3.</td>
</tr>
</tbody>
</table>

Table 3.2-1 SWD Interface Pin Definition and Description

3.2.1 ICE Programming Connection

The Nu-Link2-Pro provides ICE function to Programming and debugging on PC. The ICE connection pins are VCC(CON4.1), ICE_DAT(CON4.3), ICE_CLK(CON4.5), /RESET(CON4.7) and VSS(CON4.9). Figure 3.2-1 presents how to connect the target board to use ICE and Table 3.2-2 shows the pin corresponding to the target board.
The Nu-Link2-Pro provides virtual COM port (VCOM) function to print out messages on PC, and the Virtual COM transmission data by UART0. The connection pins are VCC (CON4.1), VSS (CON4.9), TX (CON4.8) and RX (CON4.10). Figure 3.2-2 presents how to connect the target board to use VCOM and Table 3.2-3 shows the pin corresponding to the target board.
3.2.3 **Automatic IC Programming Connection**

The Nu-Link2-Pro provides Automatic IC Programming function to mass production. The Automatic IC Programming connection pins are VCC (CON4.1), VSS (CON4.9), BUSY (CON4.2), START (CON4.4), PASS (CON4.8) and FAIL (CON4.10). Figure 3.2-3 presents how to connect the target board to use Automatic IC Programming and Table 3.2-4 shows the pin corresponding to the target board.

<table>
<thead>
<tr>
<th>Pin Name</th>
<th>Pin Number</th>
<th>Pin Corresponding to the Target Board</th>
</tr>
</thead>
<tbody>
<tr>
<td>VCC</td>
<td>CON4.1</td>
<td>VCC</td>
</tr>
<tr>
<td>PASS/TX</td>
<td>CON4.8</td>
<td>UART_RX</td>
</tr>
<tr>
<td>VSS(GND)</td>
<td>CON4.9</td>
<td>VSS(GND)</td>
</tr>
<tr>
<td>FAIL/RX</td>
<td>CON4.10</td>
<td>UART_TX</td>
</tr>
</tbody>
</table>

Table 3.2-3 SWD Interface Corresponding Pin for Virtual COM
Figure 3.2-3 SWD Interface Connection Diagram for Automatic IC Programming

<table>
<thead>
<tr>
<th>Pin Name</th>
<th>Pin Number</th>
<th>Pin Corresponding to the Target Board</th>
</tr>
</thead>
<tbody>
<tr>
<td>VCC</td>
<td>CON4.1</td>
<td>VCC[1]</td>
</tr>
<tr>
<td>BUSY</td>
<td>CON4.2</td>
<td>BUSY</td>
</tr>
<tr>
<td>START</td>
<td>CON4.4</td>
<td>START</td>
</tr>
<tr>
<td>PASS</td>
<td>CON4.8</td>
<td>PASS</td>
</tr>
<tr>
<td>VSS(GND)</td>
<td>CON4.9</td>
<td>VSS(GND)</td>
</tr>
<tr>
<td>FAIL</td>
<td>CON4.10</td>
<td>FAIL</td>
</tr>
</tbody>
</table>

Note:
1. The target board power setting should be the same as Nu-Link2-Pro.

Table 3.2-4 SWD Interface Corresponding Pin for Automatic IC Programming
3.3 Bridge Interface Pin Definition and Function Connection

Table 3.3-1 shows the bridge interface pin definition and description. The Nu-Link2-Pro provides a bridge interface connector with a 100-mil 20-pin cable. The bridge interface supports one channel UART, I²C, SPI, RS-485, CAN BUS, ADC, PWM and two GPIOs. The following sections will introduce the definition of the bridge interface pin and the connection of each function.

<table>
<thead>
<tr>
<th>Pin Name</th>
<th>Pin Number</th>
<th>Pin Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXD</td>
<td>CON6.1</td>
<td>Data transmitter output pin for UART</td>
</tr>
<tr>
<td>RXD</td>
<td>CON6.2</td>
<td>Data receiver input pin for UART</td>
</tr>
<tr>
<td>SCL</td>
<td>CON6.3</td>
<td>I²C clock</td>
</tr>
<tr>
<td>SDA</td>
<td>CON6.4</td>
<td>I²C data input/output</td>
</tr>
<tr>
<td>SS</td>
<td>CON6.5</td>
<td>SPI slave select</td>
</tr>
<tr>
<td>CLK</td>
<td>CON6.6</td>
<td>SPI serial clock</td>
</tr>
<tr>
<td>MOSI</td>
<td>CON6.7</td>
<td>SPI MOSI (Master Out, Slave In)</td>
</tr>
<tr>
<td>MISO</td>
<td>CON6.8</td>
<td>SPI MISO (Master In, Slave Out)</td>
</tr>
<tr>
<td>RS-485A</td>
<td>CON6.9</td>
<td>RS-485 Data plus signal</td>
</tr>
<tr>
<td>RS-485B</td>
<td>CON6.10</td>
<td>RS-485 Data minus signal</td>
</tr>
<tr>
<td>CANH</td>
<td>CON6.11</td>
<td>CAN BUS Data plus signal</td>
</tr>
<tr>
<td>CANL</td>
<td>CON6.12</td>
<td>CAN BUS Data minus signal</td>
</tr>
<tr>
<td>ADC</td>
<td>CON6.13</td>
<td>ADC analog input signal</td>
</tr>
<tr>
<td>VCC33</td>
<td>CON6.14</td>
<td>Target Board voltage supply. The Nu-Link2-Pro Bridge VCC only support 3.3V.</td>
</tr>
<tr>
<td>PWM</td>
<td>CON6.15</td>
<td>PWM output/Capture input</td>
</tr>
<tr>
<td>VCC33</td>
<td>CON6.16</td>
<td>Target Board voltage supply. The Nu-Link2-Pro Bridge VCC only support 3.3V.</td>
</tr>
<tr>
<td>GPIO0</td>
<td>CON6.17</td>
<td>General Purpose I/O 0</td>
</tr>
<tr>
<td>GND</td>
<td>CON6.18</td>
<td>Ground</td>
</tr>
<tr>
<td>GPIO1</td>
<td>CON6.19</td>
<td>General Purpose I/O 1</td>
</tr>
<tr>
<td>GND</td>
<td>CON6.20</td>
<td>Ground</td>
</tr>
</tbody>
</table>

Table 3.3-1 Bridge Interface Pin Definition and Description

3.3.1 UART Connection

The Nu-Link2-Pro provides one channel UART function for monitor mode print out information. This information is received from I²C, SPI, RS-485 or CAN BUS. The UART connection pins are VCC33 (CON6.14 and CON6.16), VSS(CON6.18 and CON6.20), TXD(CON6.1) and RXD(CON6.2). Figure 3.3-1 presents how to connect the target board to use UART function and Table 3.3-2 shows the pin
corresponding to the target board.

![Diagram of NuMicro® Family Target Board](image)

**Figure 3.3-1 Bridge Interface Connection Diagram for UART**

<table>
<thead>
<tr>
<th>Pin Name</th>
<th>Pin Number</th>
<th>Pin Corresponding to the Target Board</th>
</tr>
</thead>
<tbody>
<tr>
<td>TXD</td>
<td>CON6.1</td>
<td>RXD[1]</td>
</tr>
<tr>
<td>RXD</td>
<td>CON6.2</td>
<td>TXD[1]</td>
</tr>
<tr>
<td>VCC33</td>
<td>CON6.14</td>
<td>VCC[1]</td>
</tr>
<tr>
<td>VCC33</td>
<td>CON6.16</td>
<td>VCC[1]</td>
</tr>
<tr>
<td>VSS(GND)</td>
<td>CON6.18</td>
<td>VSS(GND)</td>
</tr>
<tr>
<td>VSS(GND)</td>
<td>CON6.20</td>
<td>VSS(GND)</td>
</tr>
</tbody>
</table>

**Note:**
1. The target board power and signal only supports 3.3V at Nu-Link2-Pro Bridge interface.

**Table 3.3-2 Bridge Interface Corresponding Pin for UART**

**3.3.2 I²C Connection**

The Nu-Link2-Pro provides one channel I²C function for monitor mode receive information, and print out...
information by UART. The I\(^2\)C connection pins are VCC33(CON6.14 and CON6.16), VSS (CON6.18 and CON6.20), SCL(CON6.3) and SDA(CON6.4). Figure 3.3-2 presents how to connect the target board to use I\(^2\)C function and Table 3.3-3 shows the pin corresponding to the target board.

![Bridge Interface Connection Diagram for I\(^2\)C](image)

<table>
<thead>
<tr>
<th>Pin Name</th>
<th>Pin Number</th>
<th>Pin Corresponding to the Target Board</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCL(^1)</td>
<td>CON6.3</td>
<td>SCL(^2)</td>
</tr>
<tr>
<td>SDA(^1)</td>
<td>CON6.4</td>
<td>SDA(^2)</td>
</tr>
<tr>
<td>VCC33</td>
<td>CON6.14</td>
<td>VCC(^2)</td>
</tr>
<tr>
<td>VCC33</td>
<td>CON6.16</td>
<td>VCC(^2)</td>
</tr>
<tr>
<td>VSS(GND)</td>
<td>CON6.18</td>
<td>VSS(GND)</td>
</tr>
<tr>
<td>VSS(GND)</td>
<td>CON6.20</td>
<td>VSS(GND)</td>
</tr>
</tbody>
</table>

**Note:**
1. Internal 4.7 k\(\Omega\) pull-up resistors R67 and R68 on Nu-Link2-Pro; the user can adjust them according to needs.
2. The target board power and signal only support 3.3 V at Nu-Link2-Pro Bridge interface.

Table 3.3-3 Bridge Interface Pin for I\(^2\)C
3.3.3 SPI Connection

The Nu-Link2-Pro provides one channel SPI function for monitor mode receive information, and print out information by UART. The SPI connection pins are VCC33(CON6.14 and CON6.16), VSS (CON6.18 and CON6.20), SS(CON6.5), CLK(CON6.6), MOSI(CON6.7) and MISO(CON6.8). Figure 3.3-3 presents how to connect the target board to use SPI function and Table 3.3-4 shows the pin corresponding to the target board.

Figure 3.3-3 Bridge Interface Connection Diagram for SPI

<table>
<thead>
<tr>
<th>Pin Name</th>
<th>Pin Number</th>
<th>Pin Corresponding to the Target Board</th>
</tr>
</thead>
<tbody>
<tr>
<td>SS</td>
<td>CON6.5</td>
<td>SS[1]</td>
</tr>
<tr>
<td>CLK</td>
<td>CON6.6</td>
<td>CLK[1]</td>
</tr>
<tr>
<td>MOSI</td>
<td>CON6.7</td>
<td>MOSI[1]</td>
</tr>
<tr>
<td>MISO</td>
<td>CON6.8</td>
<td>MISO[1]</td>
</tr>
<tr>
<td>VCC33</td>
<td>CON6.14</td>
<td>VCC[1]</td>
</tr>
<tr>
<td>VCC33</td>
<td>CON6.16</td>
<td>VCC[1]</td>
</tr>
<tr>
<td>VSS (GND)</td>
<td>CON6.18</td>
<td>VSS (GND)</td>
</tr>
</tbody>
</table>
3.3.4 RS-485 Connection

The Nu-Link2-Pro provides one channel RS-485 function for monitor mode receive information, and print out information by UART. The RS-485 connection pins are VCC33(CON6.14 and CON6.16), VSS(CON6.18 and CON6.20), RS485A(CON6.9) and RS485B(CON6.10). Figure 3.3-4 presents how to connect the target board to use RS-485 function and Table 3.3-5 shows the pin corresponding to the target board.

<table>
<thead>
<tr>
<th>Pin Name</th>
<th>Pin Number</th>
<th>Pin Corresponding to the Target Board</th>
</tr>
</thead>
<tbody>
<tr>
<td>VCC33</td>
<td>CON6.14</td>
<td>VCC[2]</td>
</tr>
<tr>
<td>VCC33</td>
<td>CON6.16</td>
<td>VCC[2]</td>
</tr>
</tbody>
</table>
3.3.5 **CAN BUS Connection**

The Nu-Link2-Pro provides one channel CAN BUS function for monitor mode receive information, and print out information by UART. The CAN BUS connection pins are VCC33(CON6.14 and CON6.16), VSS(CON6.18 and CON6.20), CANH(CON6.11) and CANL(CON6.12). Figure 3.3-5 presents how to connect the target board to use CAN BUS function and Table 3.3-6 shows the pin corresponding to the target board.

<table>
<thead>
<tr>
<th>Pin Name</th>
<th>Pin Number</th>
<th>Pin Corresponding to the Target Board</th>
</tr>
</thead>
<tbody>
<tr>
<td>CANH[1]</td>
<td>CON6.11</td>
<td>CANH</td>
</tr>
</tbody>
</table>

---

**Table 3.3-5 Bridge Interface Corresponding Pin for RS-485**

**Note:**
1. Internal 120 Ω terminal resistors R62 on Nu-Link2-Pro; the user can adjust them according to needs.
2. The target board power and signal only support 3.3 V at Nu-Link2-Pro Bridge interface.
3.3.6 **PWM and Capture**

The Nu-Link2-Pro provides one channel PWM function for user flexible planning. The PWM connection pins are VCC33(CON6.14 and CON6.16), VSS(CON6.18 and CON6.20) and PWM(CON6.15). Figure 3.3-6 presents how to connect the target board to use PWM function and Table 3.3-7 shows the pin corresponding to the target board.

<table>
<thead>
<tr>
<th>CANL[1]</th>
<th>CON6.12</th>
<th>CANL</th>
</tr>
</thead>
<tbody>
<tr>
<td>VCC33</td>
<td>CON6.14</td>
<td>VCC[2]</td>
</tr>
<tr>
<td>VCC33</td>
<td>CON6.16</td>
<td>VCC[2]</td>
</tr>
<tr>
<td>VSS(GND)</td>
<td>CON6.18</td>
<td>VSS(GND)</td>
</tr>
<tr>
<td>VSS(GND)</td>
<td>CON6.20</td>
<td>VSS(GND)</td>
</tr>
</tbody>
</table>

**Note:**
1. Internal 120 Ω terminal resistors R63 on Nu-Link2-Pro; the user can self-adjust them according to needs.
2. The target board power and signal only support 3.3 V at Nu-Link2-Pro Bridge interface.

Table 3.3-6 Bridge Interface Corresponding Pin for CAN BUS
### Table 3.3-7 Bridge Interface Corresponding Pin for PWM

<table>
<thead>
<tr>
<th>Pin Name</th>
<th>Pin Number</th>
<th>Pin Corresponding to the Target Board</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWM</td>
<td>CON6.15</td>
<td>GPIO or Application side [1]</td>
</tr>
<tr>
<td>VCC33</td>
<td>CON6.14</td>
<td>VCC[1]</td>
</tr>
<tr>
<td>VCC33</td>
<td>CON6.16</td>
<td>VCC[1]</td>
</tr>
<tr>
<td>VSS(GND)</td>
<td>CON6.18</td>
<td>VSS(GND)</td>
</tr>
<tr>
<td>VSS(GND)</td>
<td>CON6.20</td>
<td>VSS(GND)</td>
</tr>
</tbody>
</table>

**Note:**

1. The target board power and signal only support 3.3 V at Nu-Link2-Pro Bridge interface.

---

### 3.3.7 ADC Connection

The Nu-Link2-Pro provides one channel ADC function for user flexible planning. The ADC connection pins are VCC33(CON6.14 and CON6.16), VSS(CON6.18 and CON6.20) and ADC(CON6.13). Figure 3.3-7 presents how to connect the target board to use ADC function and Table 3.3-8 shows the pin corresponding to the target board.
### 3.3.8 GPIO Connection

The Nu-Link2-Pro provides two channel GPIO function for user flexible planning. The GPIO connection pins are VCC33(CON6.14 and CON6.16), VSS(CON6.18 and CON6.20), GPIO0(CON6.17) and GPIO1(CON6.19). Figure 3.3-8 presents how to connect the target board to use GPIO function and Table 3.3-9 shows the pin corresponding to the target board.
<table>
<thead>
<tr>
<th>Pin Name</th>
<th>Pin Number</th>
<th>Pin Corresponding to the Target Board</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPIO0</td>
<td>CON6.17</td>
<td>GPIO or Application side [1]</td>
</tr>
<tr>
<td>GPIO1</td>
<td>CON6.19</td>
<td>GPIO or Application side [1]</td>
</tr>
<tr>
<td>VCC33</td>
<td>CON6.14</td>
<td>VCC [1]</td>
</tr>
<tr>
<td>VCC33</td>
<td>CON6.16</td>
<td>VCC [1]</td>
</tr>
<tr>
<td>VSS(GND)</td>
<td>CON6.18</td>
<td>VSS(GND)</td>
</tr>
<tr>
<td>VSS(GND)</td>
<td>CON6.20</td>
<td>VSS(GND)</td>
</tr>
</tbody>
</table>

**Note:**
1. The target board power and signal only support 3.3V at Nu-Link2-Pro Bridge interface.

Table 3.3-9 Bridge Interface Corresponding Pin for GPIO
3.4 **ETM Interface Pin Definition and Function Connection**

Table 3.4-1 shows ETM interface pin definition and description. The Nu-Link2-Pro provide a ETM interface connector with a 50-mil 20-pin cable. The ETM interface supports ETM and SWD function. The following sections will introduce the definition of the ETM interface pin and the connected of each function.

<table>
<thead>
<tr>
<th>Pin Name</th>
<th>Pin Number</th>
<th>Pin Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VCC33</td>
<td>CON3.1</td>
<td>Target Board voltage supply. The Nu-Link2-Pro ETM VCC only supports 3.3V.</td>
</tr>
<tr>
<td>SWDIO</td>
<td>CON3.2</td>
<td>Serial Wired Debugger Data pin</td>
</tr>
<tr>
<td>GND</td>
<td>CON3.3</td>
<td>Ground</td>
</tr>
<tr>
<td>SWDCLK</td>
<td>CON3.4</td>
<td>Serial Wired Debugger Clock pin</td>
</tr>
<tr>
<td>GND</td>
<td>CON3.5</td>
<td>Ground</td>
</tr>
<tr>
<td>NC</td>
<td>CON3.6</td>
<td>NC</td>
</tr>
<tr>
<td>KEY</td>
<td>CON3.7</td>
<td>A key pin to properly orient the connector.</td>
</tr>
<tr>
<td>NC</td>
<td>CON3.8</td>
<td>NC</td>
</tr>
<tr>
<td>GND</td>
<td>CON3.9</td>
<td>Ground</td>
</tr>
<tr>
<td>/RESET</td>
<td>CON3.10</td>
<td>IC reset pin, Nu-Link2-Pro will automatically reset the target IC during the programming process.</td>
</tr>
<tr>
<td>NC</td>
<td>CON3.11</td>
<td>NC</td>
</tr>
<tr>
<td>TRACECLK</td>
<td>CON3.12</td>
<td>ETM trace clock pin.</td>
</tr>
<tr>
<td>NC</td>
<td>CON3.13</td>
<td>Ground</td>
</tr>
<tr>
<td>TRACEDATA[0]</td>
<td>CON3.14</td>
<td>ETM trace data output pin.</td>
</tr>
<tr>
<td>GND</td>
<td>CON3.15</td>
<td>Ground</td>
</tr>
<tr>
<td>TRACEDATA[1]</td>
<td>CON3.16</td>
<td>ETM trace data output pin.</td>
</tr>
<tr>
<td>GND</td>
<td>CON3.17</td>
<td>Ground</td>
</tr>
<tr>
<td>GND</td>
<td>CON3.19</td>
<td>Ground</td>
</tr>
</tbody>
</table>

Table 3.4-1 ETM Interface Pin Definition and Description

3.4.1 **SWD Connection**

The ETM interface provides SWD function for IC programming and Debugging. Figure 3.4-1 presents how to connect the target board to use SWD function. In addition, please pay attention to the behavior and do not program or debug at the same time with the SWD interface; otherwise, an error will occur.
3.4.2 **ETM Connection**

The ETM interface provides ETM function for capturing execution steps of microprocessor on the target board, and ETM will display them in a readability format. Figure 3.4-1 presents how to connect the target board to use ETM function.

3.5 **ICP Offline Programming Function Connection**

The Nu-Link2-Pro provides three kinds of storage interfaces for Nu-Link2-Pro ICP offline programming. The user can save the bin file to USB Flash drive, Micro SD card or SPI Flash for offline programming. The priority of reading from these three storage is USB Flash drive > Micro SD card > SPI Flash. Figure 3.5-1 presents how to connect the target board to use GPIO function.
1. USB Flash drive

2. Micro SD card

3. SPI Flash

ICP Offline Programming

Figure 3.5-1 ICP Offline Programming Illustration of SWD Interface
4 DEBUGGING AND PROGRAMMING

4.1 Debugging
This section briefly describes the debugging function supported by the Nu-Link2-Pro. For more details, please refer to the related user manuals.

4.1.1 Debug Mode
The Nu-Link2-Pro supports debugging for the NuMicro® Family chips based on the SWD signal interface. The third-party tools that support using the Nu-Link2-Pro for chip debugging include Keil MDK, IAR EWARM, and NuEclipse GCC. Some more functions supported in Debug mode are described as follows.

4.1.2 Breakpoints
In Debug mode, the user can add breakpoints in the code for debugging. During the real-time simulation of the Nu-Link2-Pro, the chip simulation will be stopped at a specific breakpoint. Figure 4.1-1 shows the breakpoint settings in Keil MDK Debug mode. The red labels on lines 052 and 059 indicate the breakpoints inserted; the yellow arrow refers to the code to be executed next and shows the register value of Program Counter (PC) (i.e., “R15(PC)=0x00000D04” in the Registers pane in Figure 4.1-1).

Figure 4.1-1 Setting Breakpoints in Keil MDK Debug Mode

4.1.3 System Viewer
The System Viewer can be used to display the register content in a target chip and manipulate the registers. Take Keil MDK Debug mode for example, invoke the View → System Viewer command and select a register from the “function register list” (e.g., ADC, CAN, CLK, etc.) to open the System Viewer of the selected register, as shown in Figure 4.1-2.
The System Viewer for CLK is shown in Figure 4.1-3, where the lower side shows the register address and description, and the upper side shows the register value.

**Detailed Operation:**

Double-clicking a “register name” will open the register control details, as shown in Figure 4.1-3. The “register value” can be modified directly. The Nu-Link2-Pro will modify the content of the target chip.
4.1.4 Semihost

When using the Semihost function, the message of the NuMicro® Family microcontroller can be output through UART to the debug window by the Nu-Link2-Pro. That is, the message is output without the GPIO. Figure 4.1-4 shows the debug messages in the “UART #1” form, which are the messages output by the Nu-Link2-Pro.

Follow the steps below to use the Semihost (taking the Keil MDK and M031 series as example).

**Step 1:** Invoking Project → Options for Target ‘Semihost’ → C/C++, and paste “DEBUG_ENABLE_SEMIHOST” in the Define field to enable semihost.

**Step 2:** Invoke Rebuild to rebuild a project and enter Debug mode.
Step 3: In Debug mode, invoke View → Serial Windows → UART #1, as shown in Figure 4.1-4.

Step 4: Press F5 to program the target chip, and the debug messages are output to the UART #1 form.

4.1.5 Embedded Trace Macrocell (ETM)

Nu-Link2-Pro supports the Embedded Trace Macrocell function that can show every single executed instruction in the current application to PC. For detailed settings and usage, please refer to section 5.2.2.3.
4.2 Programming
This section will briefly describe the programming function supported by the Nu-Link2-Pro. For more details, please refer to the related user manuals.

4.2.1 ICP Online Programming
Online Programming means that the Nu-Link2-Pro can download the firmware of the NuMicro® Family single chip to the target chip through software programs, as shown in Figure 4.2-1.

![Figure 4.2-1 Online Programming Flow Diagram]

4.2.2 ICP Offline Programming
Offline Programming means that the Nu-Link2-Pro can update the firmware of the NuMicro® Family single chip directly without accessing software programs (as shown in Figure 4.2-2). Offline programming is useful for mass production since the original code or firmware file does not need to be delivered and only the Nu-Link2-Pro is needed for mass production. In addition, the Nu-Link2-Pro supports “Limited Offline Programming,” which can effectively control the authorized number of the firmware. For details, please refer to the ICP Tool User Manual.

Nu-Link2-Pro has three interfaces to download the offline data for offline download.

1. USB flash drive.
2. SD card.
3. Embedded SPI flash of Nu-Link2-Pro (offline download usage is same as Nu-Link).

Please follow the steps below to use USB flash drive or SD card interface for offline download:

1. Use Tool -> Create Offline USB/SD File on the menu bar of ICP Tool to save NuLink2.us file and drag and drop the file into USB flash drive or SD card.
2. Plug USB flash drive or SD card into Nu-Link2-Pro.

Pressing the button on the Nu-Link2-Pro will switch the Nu-Link2-Pro to offline download mode and start to download the offline data to target chip immediately.

The Nu-Link2-Pro also supports Control Bus so that can use the automatic IC programming function.
during mass production. For details, please refer to the section 6.3.

![Diagram of Offline Programming Flow Diagram](image)

**Figure 4.2-2 Offline Programming Flow Diagram**

### 4.2.3 ISP Online Programming
The ISP tool currently only supports online programming and the programming interface supports UART, I²C, SPI, RS-485 and CAN BUS. Table 5.2-2 show the connection method of each interface and please refer to the section 5.2.5 for ISP online programming details.

### 4.2.4 Software Serial Number (SN)
The Software Serial Number (SN) function provided by the ICP Tool enables users to specify the value in the **Increase SN from** and **Write address in flash** fields for the target chip during online/offline programming. Take the M031 series chip for example, the user can specify a set of “Increased Serial Number (SN)” and “Write Address” to any of APROM, LDROM, and Data Flash, and the written Serial Number (SN) will be automatically incremented (as shown in Figure 4.2-3).
4.3 **Wide Voltage Programming**

The Nu-Link2-Pro supports the wide voltage programming function, by which the development software tool can adjust the SWD port voltage as 1.8 V, 2.5 V, 3.3 V, or 5.0 V. As shown in Figure 3.2-1, the pins that can be controlled include VCC, ICE_DAT, ICE_CLK, and /RESET.

4.4 **Installing the Nu-Link2-Pro Driver**

The Nu-Link2-Pro supports a variety of functions and third-party software tools (e.g., Keil MDK and IAR EWARM). After the software programs are installed, the drivers are also required. You can use the following links: [Nu-Link_Keil_Driver](#) for Keil MDK and [Nu-Link_IAR_Driver](#) for IAR EWARM to install the latest version. For details about software setup, please refer to section 5.2.
5 INSTALLATION AND SETUP
This chapter introduces how to connect the Nu-Link2-Pro to a computer, and how to set the third-party tool to use the Nu-Link2-Pro as a debugger and a programmer.

5.1 Connecting to the Nu-Link2-Pro
As shown in Figure 5.1-1, the Nu-Link2-Pro is a bridge between an USB and the SWD interface, by which software tools can debug and program the target chip through an USB. The user can plug the Nu-Link2-Pro into an USB port of a PC directly or connect using the USB connector. About connection method please refer to section 3.2 for details.

Through a SWD port, the Nu-Link2-Pro can supply power (1.8 V, 2.5 V, 3.3 V, or 5.0 V) to a target circuit board. The maximum is 5 V/500 mA. Refer to Table 6.1-1 for detailed specifications.

![Figure 5.1-1 Nu-Link2-Pro Connection Diagram](image)

SWD Connector:
The SWD connector, which can be applied to all of the NuMicro® development tools and evaluation boards, is a 100 mil (2×5) female header, as shown in the left of Figure 3.2-1.
5.2 Software Setup
This section briefly describes required software settings for connecting to the Nu-Link2-Pro. For detailed software operation, refer to the related user manuals.

5.2.1 ICP Tool
(1) Download and install NuVoton NuMicro® ICP Programming Tool.
(2) Open the ICP Tool, specify the UI language and target chip, and then click Continue, as shown in Figure 5.2-1.

![Figure 5.2-1 Startup Screen of ICP Tool](image)

(3) In the ICP Tool window, the connection status is shown as “Disconnected” since the ICP tool has not been connected with the Nu-Link2-Pro, as shown in Figure 5.2-2.

![Figure 5.2-2 ICP Tool Main Window](image)
(4) And then click the Connect button. Go to (5) if more than one Nu-Link2-Pro are connected with the host. Go to (6) if only one Nu-Link2-Pro is connected with the host.

(5) If two Nu-Link Debugger and Programmers have been connected with the computer, a message appears and asks to select one from the two adapters. Clicking OK will connect the selected adapter with the host, as shown in Figure 5.2-3. When a Nu-Link2-Pro is selected for connection, the Status LED starts blinking.

![Figure 5.2-3 Select One Nu-Link2-Pro](image)

(6) Click Option in the Programming section of the ICP Tool Window to open the Program Option form, as shown in Figure 5.2-4.

(7) In the Nu-Link Pro IO Voltage section, specify the power voltage of the SWD port for the target chip, and then click OK. To use the offline programming function, the Offline Programming mode option needs to be selected, as shown in Figure 5.2-4.

![Figure 5.2-4 ICP Tool Programming Options](image)

(8) After the Connect button is clicked, the ICP Tool will be connected with the Nu-Link2-Pro, and a
SWD port will be detected. Figure 5.2-5 shows that the ICP Tool has been connected with the Nu-Link2-Pro and a target chip is detected. At this time, the user can start programming the target chip.

![Figure 5.2-5 Nu-Link2-Pro Connected with a Target Chip Detected](image)

(9) Figure 5.2-6 shows that the ICP Tool has been connected with the Nu-Link2-Pro with no target chip detected. The ICP tool will continue detecting the target chip until the Stop Check button is clicked. At this time, the user cannot program any chip, but can use the offline programming to save the offline programming information in the Nu-Link2-Pro.

![Figure 5.2-6 Nu-Link2-Pro Connected with No Target Chip Detected](image)

(10) Click the Disconnect button if programming is not needed (as shown in Figure 5.2-5). Or click the Stop Check button to disconnect the ICP Tool with the Nu-Link2-Pro and leave the Nu-Link2-Pro unused (as shown in Figure 5.2-6). As such, the Nu-Link2-Pro can be connected with another tool.

(11) As shown in Figure 5.2-7, select the ".bin" file you want to program APROM and LDROM, and tick the memory location.

(12) Click the Start button to start programming.

(13) As shown in Figure 5.2-8, click the OK button in the programming completion window to complete the operation.
Figure 5.2-7 Programming File Selection Window

Figure 5.2-8 Programming Completion Window
5.2.2 Keil MDK

Install Keil MDK. Before setting the Nu-Link2-Pro, make sure the Nu-Link Keil Driver for Keil MDK has been downloaded and installed such that the Keil MDK can recognize the Nu-Link2-Pro.

(1) Double click the Template.uvproj to open the project.

**Note:** If Figure 5.2-9 warning message jumps out, please migrate to version 5 formats as shown in Figure 5.2-10. The .uvproj filename extension will change to .uvprojx.t.

![Figure 5.2-9 Warning Message of “Device not found”](image)

![Figure 5.2-10 Project File Migrate to Version 5 Format](image)

5.2.2.1 Debugger Settings

(2) Invoke Project → Options for Target → Output, and enable the Debug Information option, as shown in Figure 5.2-11.
(3) Invoke **Project → Options for Target → Debug**, and make sure the **Use: NuVoton Nu-Link Debugger** option is checked, as shown in Figure 5.2-12 and Figure 5.2-13.
(4) Click the **Settings** button to open the **Debug** form, as shown in Figure 5.2-14. Refer to Table 5.2-1 for each setting description. The setting options shown in the Debug form may vary depending on the type of the Nu-Link2-Pro used.

<table>
<thead>
<tr>
<th>Debug Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Driver Version</td>
<td>Display the Nu-Link2-Pro driver version in the host</td>
</tr>
<tr>
<td>Chip Type</td>
<td>Specify the Target chip type</td>
</tr>
<tr>
<td>Reset</td>
<td>Select <strong>Auto detect</strong> to reset the target chip</td>
</tr>
</tbody>
</table>
IO Voltage | Specify the SWD port I/O voltage for the target chip; options include 1.8 V, 2.5 V, 3.3 V, and 5 V[1]  

Table 5.2-1 Debugger Function Settings Description  

[1] Nu-Link2-Pro will automatically determine the target chip support voltage. If the voltage only supports 3.3 V, it will automatically set to 3.3 V power supply.  

5.2.2.2 Programmer Settings  

(5) Invoke Project → Options for Target → Utilities, select “Nuvoton Nu-Link Debugger” when the Use Target Driver for Flash Programming option is enabled, and then select the Update Target before Debugging option, as shown in Figure 5.2-15.  

Figure 5.2-15 Keil MDK Programmer Selection  

(6) Click the Settings button to open the Flash Download form, as shown in Figure 5.2-16 where the user can specify the options before or after programming with the Nu-Link2-Pro.  

Figure 5.2-16 Nu-Link2-Pro Programming Settings  

(7) Rebuild all target files. After successfully compile the project, download code to the flash memory.
Click “Start/Stop Debug Section” button can enter debug mode.

Figure 5.2-17 Compile and Download the Project

(8) Figure 5.2-18 shows the debug mode under Keil MDK. Click “Run” and the debug message will be printed out as shown in Figure 5.2-19. User can debug the project under debug mode by checking source code, assembly language, peripherals' registers, and setting breakpoint, step run, value monitor, etc.

Figure 5.2-18 Keil MDK Debug Mode
5.2.2.3 **ETM Settings**

To start Embedded Trace Macrocell (ETM) tracing on Nuvoton Cortex®-M4/M23 devices, please connect to the device using the Nu-Link2-Pro with 20-pin connector and follow the steps below.

(9) Open the **Template.uvproj** in M480 BSP, as shown in Figure 5.2-20.

(10) Configure the NuTrace.

- As shown in Figure 5.2-21, In debug setting dialog, select the "Trace" tab.
- In "Trace Port" select **Sync Trace Port with 4 bit data**. It is possible to use other bit sizes but best to use the largest to increase the bandwidth.
- In **Capture Mode**, specify whether trace data is collected before or after a trigger.
  - **Trace After**: Capture the trace information after the trigger point and stop capturing when trace buffer is full.
  - **Trace Before**: Capture the most recent trace information before CPU is stopped.
- Select Trace Enable and ETM Trace Enable.
- Click OK to save the changes.

![Image of Trace Setup with ETM](image)

Figure 5.2-21 Trace Setup with ETM

(11) In Initialization File, please insert the script file to initialize the device’s trace pins when starting the debugger. The following is an example script file.

![Image of Initialization File for Trace Pins](image)

Figure 5.2-22 Initialize File for Trace Pins

**Note:** The Nu-Link Keil driver with the version v2.07 or later will automatically setup the trace pins when starting the debugger. The user does not need to do the above configuration.

(12) As show in Figure 5.2-23, Build and Download code to target chip.
After doing above settings, user must start the debugger. In Debug mode, please select **Debug** → **NuTrace** to invoke the tracing information dialog, and it will show every single executed instruction in the current application as shown Figure 5.2-24.

**Note:** As shown in Figure 5.2-25, it is recommended to set a break point or use single-step execution, it will be easier to track the status of the program.
Figure 5.2-25 Breakpoint setting and Execution
5.2.3 IAR EWARM

(1) Install IAR EWARM. Make sure that Nu-Link_IAR_Driver for IAR EWARM has been downloaded and installed before setting the Nu-Link2-Pro such that the IAR EWARM can recognize the Nu-Link2-Pro.

(2) Open IAR EWARM, and open the project to be set.

(3) In the Target tab of the General Options page (through invoking Project → Options), click the button in the right of the Device option (make sure the Device option is enabled), and select “Nuvoton → Nuvoton M031AE series” as the target chip (M031AE series is this case), as shown in Figure 5.2-26 and Figure 5.2-27.

![Figure 5.2-26 Options Selection](image)

![Figure 5.2-27 IAR EWARM Target Chip Selection](image)
5.2.3.1 Debugger and Programmer Settings:

(4) In the Setup tab of the Debugger page, select Third-Party Driver as the driver, as shown in Figure 5.2-28.

![Debugger and Programmer Settings](image)

Figure 5.2-28 Set IAR EWARM as Third-Party Driver for Debugger & Programmer

(5) In the Download tab of the Debugger page, make sure that the Use flash loader(s) option is selected, as shown in Figure 5.2-29.

![IAR EWARM Programming Settings](image)

Figure 5.2-29 IAR EWARM Programming Settings

(6) In the Download tab of the Debugger page, select the Override default .board file option if you want the firmware to be downloaded to APROM or LDROM, and then specify the M031_APROM.board or M031_LDROM.board file (M031 series is used in this case). If no file is founded, specify the following path "$TOOLKIT_DIR$/config/flashloader/Nuvoton", as shown in Figure 5.2-30.
5.2.3.2  Driver Plugin File Settings:

(7) In the Third-Party Driver page, specify the path of the IAR debugger driver plugin "C:\Program Files\Nuvoton Tools\Nu-Link\IAR\Nu-Link_IAR.dll", as shown in Figure 5.2-31.

(8) Click OK to save the settings and return to the IAR EWARM main window.

(9) Invoke Nu-Link2-Pro to open the Nu-Link form, select SWD as the Port, and specify the Nu-Link2-Pro I/O Voltage in the Target power control section (3.3V in this case), as shown in Figure 5.2-32.
5.2.3.3  **Start Programmer**

(10) Make target file as presented in Figure 5.2-33. After successfully compile the project, download code to the flash memory and enter debug mode.

(11) Figure 5.2-34 shows the debug mode under IAR EWARM. Click “Go” and the debug message will be printed out as shown in Figure 5.2-35. User can debug the project under debug mode by checking source code, assembly language, peripherals’ registers, and setting breakpoint, step run, value monitor, etc.
Figure 5.2-34 IAR EWARM Debug Mode

Figure 5.2-35 Debug Message on Serial Port Terminal Windows
5.2.4 **NuEclipse GCC**

(1) Install **NuEclipse GCC**, which does not require any driver installation.

(2) Double-click NuEclipse.exe to open the toolchain.

(3) Import the “Template” project by following the steps presented in Figure 5.2-36 and Figure 5.2-37.

![Figure 5.2-36 Import the Project in NuEclipse](image)

Figure 5.2-36 Import the Project in NuEclipse

![Figure 5.2-37 Import Projects Windows](image)

Figure 5.2-37 Import Projects Windows

(4) Click the “Template” project and find the project properties as shown in Figure 5.2-38.
Make sure the settings are the same as settings in Figure 5.2-39.

Figure 5.2-38 Open Project Properties Window

Figure 5.2-39 Project Properties Settings

1. Click the “Template” project and build the project.

(5) Click the “Template” project and build the project.
5.2.4.1 Debugger and Programming Settings:

(6) After the project is built, click the “Template” project and set the “Debug Configuration” as shown in Figure 5.2-41. Follow the settings presented in Figure 5.2-42, Figure 5.2-43 and Figure 5.2-44 to enter debug mode.
Figure 5.2-41 Open Debug Configuration

Note 1: Double click the “GDB Nuvoton Nu-Link Debugging” to create the subitem.

Note 2: After the project is built, the “*.elf” file will be shown in “C/C++ Application” frame.

Figure 5.2-42 Main Tab Configuration
Figure 5.2-43 Debugger Tab Configuration
Note 1: Users must follow those settings highlighted in green.

Note 2: Users can configure other settings depend on the needs.

Figure 5.2-44 Debugger Tab Configuration

(7) Figure 5.2-45 shows the debug mode under NuEclipse. Click “Resume” and the debug message will be printed out as shown in Figure 5.2-46. User can debug the project under debug mode by checking source code, assembly language, peripherals’ registers, and setting breakpoint, step run, value monitor, etc. For more information about how to use NuEclipse, please refer to the NuEclipse User Manual.
1. Resume
2. Suspend
3. Restart the debugging session
4. Terminate

Figure 5.2-45 NuEclipse Debug Mode

Figure 5.2-46 Debug Message on Serial Port Terminal Windows
5.2.5  ISP Tool

(1) Download and install Nuvoton NuMicro® ISP Programming Tool.

(2) Open the ISP Tool, select one connection interface to connect as shown in Figure 5.2-47.

![Figure 5.2-47 Startup Screen of ISP Tool](image)

(3) In the ISP Tool window, the connection status is shown as “Disconnected” since the ISP tool has not been connected with the target chip, as shown in Figure 5.2-48.

![Figure 5.2-48 ISP is not connected to any device of ISP Tool](image)

(4) Refer to section 3.3 to connect pins of Nu-Link2-Pro to target chip depend on connection interface in step 2. Connection interface option of ISP Tool mapping table as shown in Table 5.2-2.
ISP Tool Connection Interface | Pin Connection of Nu-Link2-Pro
---|---
UART\(^1\) | Refer to section 3.2.2
I^2\(^C\) | Refer to section 3.3.2
SPI | Refer to section 3.3.3
RS-485 | Refer to section 3.3.4
CAN | Refer to section 3.3.5

Table 5.2-2 Connection Interface Option of ISP Tool
\(^1\) ISP programming UART interface connection method is the same as virtual COM

(5) Download BSP sample code and open ISP firmware of Keil sample code project that it can be found in SampleCode\ISP as shown in Figure 5.2-49. The interfaces of ISP firmware sample code may be different for each NuMicro® chip series.

BSP sample code download link:
https://github.com/OpenNuvoton/
https://gitee.com/OpenNuvoton/

![Figure 5.2-49 ISP Firmware Sample Code Project](image)

(6) Invoke **Project → Options for Target → Utilities**, select “Nuvoton Nu-Link Debugger” when the **Use Target Driver for Flash Programming** option is enabled, and select the **Update Target before Debugging** option, as shown in Figure 5.2-50

![M480_Series_BSP_CMSIS_V3.XX.XXX](image)

(7) Click the **Settings** button to open the Flash Download form, as shown in Figure 5.2-50

(8) Click the **Configure** button to open the user configuration form and set **Boot Select** option to LDROM and click **OK** button as shown in Figure 5.2-50
(9) Download code to LDROM of target chip.

![Figure 5.2-50 Boot from LDROM Setting in Keil ISP Firmware Project](image)

(10) Open ISP programming tool, click **Connect** button, and reset the target chip to run ISP code. ISP programming tool will connect to target chip. For example, SPI connection interfaces as shown in Figure 5.2-51. For UART connection interface, user needs to select VCOM port number as shown in Figure 5.2-52. All of connection interfaces that provided by ISP tool can connect to target chip by using above steps except USB interface.

![Figure 5.2-51 Connect to Target Chip with SPI Interface](image)
Figure 5.2-52 Select VCOM Port Number with UART Interface

In ISP_HID firmware sample code (USB interface), there is a control pin to control target chip to run APROM or LDROM code. The control pin may be different for each NuMicro® chip series and please refer to each BSP sample code. Target chip will run APROM code when the control pin is in high and target chip will run LDROM code when the control pin is low. User must keep the control pin in low and click Connect button of ISP programming tool. ISP programming tool will connect to target chip with USB connection interface.

<table>
<thead>
<tr>
<th>ISP Interface</th>
<th>Reset and Control Pin</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPI, UART, I2C, RS-485, CAN</td>
<td>Chip reset to reboot in LDROM, ISP FW to connect ISP tool</td>
</tr>
<tr>
<td>USB</td>
<td>Chip reset to reboot in LDROM, ISP FW to check control pin in low state for ISP process</td>
</tr>
</tbody>
</table>

Table 5.2-3 Entering the ISP Conditions for ISP Tool Connection

(11) Load programming file and check the programming option and click Start button. ISP Programming Tool start to program file to target chip by user selected connection interface as shown in Figure 5.2-53.
5.2.6 More Features of Nu-Link2-Pro Firmware

Nu-Link2-Pro also provides different interface to program user code to target chip. These various feature and programming interface correspond to different firmware bin file. User can switch the roles that Nu-Link2-Pro play by re-programming Nu-Link2-Pro to another .bin file.

The brief description of Nu-Link2-Pro firmware as follows:

1. **NuLink2_DAPLink.bin**
   NuLink2_DAPLink.bin is the firmware supported ARM Mbed DAPLink and PyOCD for programming and debugging.

2. **NuLink2_ISPLink2.bin**
   NuLink2_ISPLink2.bin is the Nu-Link2-Pro firmware that can use offline mode to program code with bridge interfaces. User puts the programming data to Nu-Link2-Pro first and then programs data to target chip with bridge interface.

3. **NuLink2_Bus_Monitor.bin**
   NuLink2_Bus_Monitor.bin is the Nu-Link2-Pro firmware can monitor the bus data of NuLink2_ISP_Bridge between two connected devices.

The Nu-Link2-Pro also provides a method to update firmware by USB mass storage. Please follow the steps below:

1. Hold offline button of Nu-Link2-Pro shown in in Figure 2.3-1, plug in USB cable and release the button.
2. A “Nu-Link2” disk will show as Figure 5.2-54. (If you see disk name is "NuMicro MCU", it will upgrade DUT firmware instead of Nu-Link2-Pro itself)
(3) Drag and drop Nu-Link2 image .bin into the disk.
(4) Re-plug the USB cable to complete update firmware.

Figure 5.2-54 Update Nu-Link2 Firmware or DUT Firmware

Please click the link below for further information and resource:
https://github.com/OpenNuvoton/Nuvoton_Tools
https://github.com/OpenNuvoton/Nuvoton_Tools/tree/master/Latest_NuLink_Firmware
https://gitee.com/OpenNuvoton/Nuvoton_Tools
https://gitee.com/OpenNuvoton/Nuvoton_Tools/tree/master/Latest_NuLink_Firmware
6 APPENDIX

6.1 Nu-Link2-Pro Operating Current of ICP
When power is supplied via an USB during ICP online programming, the operating current of Nu-Link2-Pro is shown in the Table 6.1-1 below.

<table>
<thead>
<tr>
<th>SWD I/O Mode Settings</th>
<th>5.0 V</th>
<th>3.3 V</th>
<th>2.5 V</th>
<th>1.8 V</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB Input Voltage (V)</td>
<td>5.0</td>
<td>5.0</td>
<td>5.0</td>
<td>5.0</td>
</tr>
<tr>
<td>SWD I/O Voltage (V)</td>
<td>4.66</td>
<td>3.33</td>
<td>2.52</td>
<td>1.82</td>
</tr>
<tr>
<td>USB Input Current (mA)</td>
<td>128</td>
<td>117</td>
<td>115</td>
<td>113</td>
</tr>
</tbody>
</table>

Table 6.1-1 Nu-Link2-Pro Operating Current (Online Programming)

When power is supplied from a target board (SWD VCC pin) during offline programming and offline file on SPI flash, the operating current of Nu-Link2-Pro is shown in the Table 6.1-2 below.

<table>
<thead>
<tr>
<th>Power Supplied from a Target Board</th>
<th>5.0 V</th>
<th>3.3 V</th>
<th>2.5 V</th>
<th>1.8 V</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Supplied via an USB</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>SWD VCC Input Voltage (V)</td>
<td>5.01</td>
<td>3.33</td>
<td>2.51</td>
<td>1.82</td>
</tr>
<tr>
<td>SWD VCC Input Current (mA)</td>
<td>77.5</td>
<td>127.5</td>
<td>155.4</td>
<td>167.5</td>
</tr>
</tbody>
</table>

Table 6.1-2 Nu-Link2-Pro Operating Current (Offline Programming) of SPI Flash

When power is supplied from a target board (SWD VCC pin) during offline programming and offline file on USB flash drive, the operating current of Nu-Link2-Pro is shown in the Table 6.1-3 below.

<table>
<thead>
<tr>
<th>Power Supplied from a Target Board</th>
<th>5.0 V</th>
<th>3.3 V</th>
<th>2.5 V</th>
<th>1.8 V</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Supplied via an USB</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>SWD VCC Input Voltage (V)</td>
<td>5.00</td>
<td>3.22</td>
<td>2.52</td>
<td>1.82</td>
</tr>
<tr>
<td>SWD VCC Input Current (mA)</td>
<td>77.6</td>
<td>123.3</td>
<td>152.6</td>
<td>161.7</td>
</tr>
</tbody>
</table>

Table 6.1-3 Nu-Link2-Pro Operating Current (Offline Programming) of USB Flash

When power is supplied from a target board (SWD VCC pin) during offline programming and offline file on Micro SD card, the operating current of Nu-Link2-Pro is shown in the Table 6.1-4 below.

<table>
<thead>
<tr>
<th>Power Supplied from a Target Board</th>
<th>5.0 V</th>
<th>3.3 V</th>
<th>2.5 V</th>
<th>1.8 V</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Supplied via an USB</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>SWD VCC Input Voltage (V)</td>
<td>5.01</td>
<td>3.28</td>
<td>2.53</td>
<td>1.81</td>
</tr>
<tr>
<td>SWD VCC Input Current (mA)</td>
<td>77.3</td>
<td>125.5</td>
<td>154.6</td>
<td>165.2</td>
</tr>
</tbody>
</table>

Table 6.1-4 Nu-Link2-Pro Operating Current (Offline Programming) of Micro SD Card
6.2  Nu-Link2-Pro Operating Current of ISP

The operating current of Nu-Link2-Pro during ISP online programming with power supply via USB is shown in the Table 6.2-1 below.

<table>
<thead>
<tr>
<th>ISP programming Interface</th>
<th>I²C</th>
<th>SPI</th>
<th>RS-485</th>
<th>CAN</th>
<th>UART</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB VCC Input Current (mA)</td>
<td>117.1</td>
<td>114.3</td>
<td>151</td>
<td>191</td>
<td>114.2</td>
</tr>
<tr>
<td>Target board Input Current (mA)</td>
<td>11.9</td>
<td>15.1</td>
<td>47.1</td>
<td>90.1</td>
<td>15</td>
</tr>
</tbody>
</table>

Table 6.2-1 Operating Current of ISP Online Programming
6.3 Automatic IC Programming System

The automatic IC programming system through individual slot and the Control Bus as Figure 6.3-1.

![SWD Connector Pin Diagrams](image)

Figure 6.3-1 SWD Connector Pin Diagrams

6.3.1 Operation Sequence and Waveform

1. The Nu-Link2-Pro power on. START, BUSY, PASS, and FAIL are set to logic.

2. To start programming, START needs to be set to logic 0 for \( T_{\text{START}} \), \( 50 \text{ms} \leq T_{\text{START}} \leq 80\text{ms} \)

3. Programming start-up. BUSY is set to logic 0, and might toggle during programming.

4. When finish programming, BUSY is set to logic 1, and PASS or FAIL is set to logic 0.
   - When BUSY is set to logic 1, and PASS is set to logic 0, means “PASS”.
   - When BUSY is set to logic 1, and FAIL is set to logic 0, means “FAIL”.

![PASS Waveform](image)

Figure 6.3-2 PASS Waveform
Figure 6.3-3 FAIL Waveform
6.1 Nu-Link Debugger and Programmer Comparison

The Nu-Link Debugger and Programmer series provides an USB connector and a SWD signal interface for connecting to the target chip. The user can connect the Nu-Link Debugger and Programmer to an USB port of a PC to debug and program target chips through the development software tools. As shown in Table 6.1-1, there are three specifications for the Nu-Link Debugger and Programmer and Table 6.1-2 two specifications for the Nu-Link Debugger and Programmer with development board, in which debugging, Online/Offline Programming, and SWD I/O voltage settings may be supported depending on the specifications (refer to the relevant section for details).

<table>
<thead>
<tr>
<th>Function</th>
<th>Type</th>
<th>Nu-Link2-Pro</th>
<th>Nu-Link-Pro</th>
<th>Nu-Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>Debug</td>
<td>Debug via SWD</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>ETM</td>
<td>✓</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>DAPLink/pyOCD</td>
<td>✓</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Program</td>
<td>Online ICP Programming</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Offline ICP-Button</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Offline ICP-Control Bus¹¹</td>
<td>✓</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Drag &amp; drop Flash programming</td>
<td>✓</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>SWD I/O Voltage Support</td>
<td>1.8V, 2.5V, 3.3V, 5.0V</td>
<td>1.8V, 2.5V, 3.3V, 5.0V</td>
<td>5.0V</td>
</tr>
<tr>
<td>Upgrade</td>
<td>Online ISP</td>
<td>✓</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Storage</td>
<td>SPI Flash</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>SD Card</td>
<td>✓</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>USB Flash Drive</td>
<td>✓</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Bridge</td>
<td>Virtual COM</td>
<td>✓</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Bus Monitor</td>
<td>I²C, SPI, CAN, RS-485</td>
<td>✓</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

Table 6.1-1 Comparison of All Nu-Link Debugger and Programmer

Note:
Nu-Link2-Pro Debugger and Programmer

1. The Nu-Link2-Pro and Nu-Link2-Me can be connected to an automatic IC programming system through the Control Bus.

<table>
<thead>
<tr>
<th>Function</th>
<th>Type</th>
<th>Nu-Link2-Me[2][3]</th>
<th>Nu-Link-Me</th>
</tr>
</thead>
<tbody>
<tr>
<td>Debug</td>
<td>Debug via SWD</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>ETM</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>DAPLink/pyOCD</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Program</td>
<td>Online ICP Programming</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Offline ICP-Button</td>
<td>✓</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Offline ICP-Control Bus[1]</td>
<td>✓</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Drag &amp; drop Flash programming</td>
<td>✓</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>SWD I/O Voltage Support</td>
<td>1.8 V, 3.3 V, 5.0 V[3]</td>
<td>3.3 V, 5.0 V[2]</td>
</tr>
<tr>
<td>Upgrade</td>
<td>Online ISP</td>
<td>✓[4]</td>
<td>-</td>
</tr>
<tr>
<td>Storage</td>
<td>SPI Flash</td>
<td>✓</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>SD Card</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>USB Flash Drive</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Bridge</td>
<td>Virtual COM</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Table 6.1-2 Comparison of Integrated Nu-Link Debugger and Programmer on Development Board

Note:

1. The Nu-Link2-Pro and Nu-Link2-Me can be connected to an automatic IC programming system through the Control Bus.
2. Adjusted by resistor JPR1.
3. Adjusted by resistor ICEJPR1.
4. Nu-Link2-Me only supports UART interface for ISP update.
7 REVISION HISTORY

<table>
<thead>
<tr>
<th>Date</th>
<th>Revision</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2020.03.13</td>
<td>1.00</td>
<td>1. Initially issued.</td>
</tr>
<tr>
<td>2020.03.24</td>
<td>1.01</td>
<td>1. Modify some related descriptions in the introduction section</td>
</tr>
</tbody>
</table>

Important Notice

Nuvoton Products are neither intended nor warranted for usage in systems or equipment, any malfunction or failure of which may cause loss of human life, bodily injury or severe property damage. Such applications are deemed, “Insecure Usage”.

Insecure usage includes, but is not limited to: equipment for surgical implementation, atomic energy control instruments, airplane or spaceship instruments, the control or operation of dynamic, brake or safety systems designed for vehicular use, traffic signal instruments, all types of safety devices, and other applications intended to support or sustain life.

All Insecure Usage shall be made at customer’s risk, and in the event that third parties lay claims to Nuvoton as a result of customer’s Insecure Usage, customer shall indemnify the damages and liabilities thus incurred by Nuvoton.